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“Moving-Away-from-MARC”-a-thon: 

Visualizing Resource Descriptions in the Linked Data Environment 


Course Summary 

This Program for Cooperative Cataloging information session will provide attendees with an 
understanding of how semantic web and linked data principles can leverage access to library 
resources and enhance user experiences. It also provides hands-on opportunities to explore 
RIMMF, a training tool that can be used to create, edit, and visualize RDA metadata, and the 
BIBFRAME Editor, a simple tool that enables input of any BIBFRAME vocabulary element.  

It is intended for BIBCO, CONSER, NACO and SACO operations representatives, standing 
committee chairs, PoCo representatives, and others associated with the PCC who attend the May 
2016 OpCo Meeting at the Library of Congress. 

Learning Objectives 

At the end of this session, participants will better understand: 
 the relevance of linked-data in processing library resources today and in the future 

 why RDF is an important linked data format  

 how RIMMF works as a training and visualization tool to view RDA outside the 
constraints of MARC 

 how the BIBFRAME Editor may be used to encode RDA bibliographic resource 
descriptions into BIBFRAME vocabulary 

 how to think of catalog elements as RDA elements rather than as MARC elements to be 
‘translated’ into RIMMF or BIBFRAME (or other visualizations) 

Training Methods 

Discussion and demonstration 

Duration 

4 hours 
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Unit 1: A Few Things We’ve Learned 

BIBFRAME vs. MARC – A Reminder on Terminology 

Some LC staff, when first seeing the BIBFRAME Editor, have asked, 
“Why does the BIBFRAME Editor use RDA vocabulary? 
Shouldn’t it use BIBFRAME vocabulary?” 

The Editor does in fact use BIBFRAME vocabulary, behind-the scenes.  The black headers and 
blue RDA element names which you see in the Editor are there to help you group the RDA 
elements by the FRBR entities -- because this is what you already know.  These bridges from 
what you know to what you don’t know are useful crutches: you enter data for the RDA terms 
you know, and the Editor ‘translates’ them into BIBFRAME vocabulary which you don’t know.  

However … 
What is not a useful crutch is to think of these as MARC elements.  Try to start ‘thinking in 
RDA’ – not ‘thinking in MARC.’ This may be a big change for you.  Currently, you don’t think 
of an element as the ‘Title Proper,’ you think of it as the 245 $a; you don’t think of it as a 
‘Contents note’ and a ‘Related work,’ you think of it as a 505 and a 7XX $at; and so on. 

Starting now: 
 Stop thinking of the elements as MARC elements.  
 Start thinking of them as RDA elements.  In fact, this should not be difficult -- the 

labels in the Editor are RDA terms, and the blue links lead to RDA instructions.
 
 Do not ask yourself: 


o “What MARC element is this?” 
o “What is the MARC coding for this element?” 

Or, put another way … 

Instead of asking … 
“Where in BIBFRAME does this 264 data get pasted?” 

Think … 
“This is the Publication Statement. The Publication Statement is Manifestation 
data. It is entered in the “Manifestation” section of the BIBFRAME profile, at 
the element titled “Publication Statement (RDA 2.8).”  

How We Think This Material Can Help 

In each of the next 4 Units, we will work with both RIMMF and BIBFRAME to create catalog 
descriptions for a resource.  For each of the four resources -- a print monograph, an online serial,  
a music score, and an MP3 download -- we will:    

1st. Create a description in RIMMF
 
2nd. Create a description in BIBFRAME 

3rd. Export the RIMMF to RDF, and discuss what we see 
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Unit 2: Print Monograph in RIMMF and BIBFRAME 

Creating a Description in RIMMF – Manual Creation 

Terms to Define 

	 The Entity Index is the list of all the “records” in the RIMMF database. It can be accessed 
by pressing <CTRL> + e or by clicking on Tools > Entity Index from the home screen. 

	 R-Tree is short for Relationship Tree. It is a visualization screen of all the relationships of 
a resource, which can start from the Person/CB/F or the W/E/M. It is an excellent way to see 
the FRBR/RDA relationships in action, as well as to check your work while in the process of 
cataloging a resource. It can be accessed at the bottom of a W/E/M record, on the bottom 
right-hand corner. We will see how the R-Tree is used at the end of this demonstration. 

Create a New Record for the Manifestation 

 Open RIMMF by double-clicking on the icon 

 Click on File > New Record for … > 
Manifestation 

 Choose a template appropriate to the type of 
Manifestation 

You may not find one that exactly matches your 
resource, so choose the closest possibility.  

Some data will be filled in for you by the particular 
template you use. This data can be changed, if 
necessary. To do this, simply place your cursor in a 
field and highlight/delete, then type the correct 
information. To delete an entire field, right-click on 
the attribute name and select Delete. 
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 Fill in the following data, if it is not already provided for you: 
 Title Proper:

 Statement of Responsibility: 


 Place of Publication:
 
 Publisher's Name: 

 Date of Publication: 

 Copyright Date: 

 Mode of Issuance: 


	 Media Type: 


	 Carrier Type: 


	 Number of Units: 


 Type of Unit (Text):  

 Dimensions: 

 Note on Related Manifestation:
 

   Transcribe 
Transcribe; note that each Statement of  
Responsibility goes in a separate field. 
Transcribe 
Transcribe 
Record. Add brackets, etc., as needed. 
Record. Press <Shift> + <F1> to produce the “©”  
Choose from the drop-down list, generally provided 

     by template, but this can be changed as necessary 
Choose from the drop-down list, generally provided 
by template, but this can be changed as necessary 

   Choose from the drop-down list, generally provided 
by template, but this can be changed as necessary 

  Record the number. If you have multiple extent 
statements, you will need to add a separate box of 
Number and Type, as needed, for each one 
Choose from the drop-down list 
Record 
List the chapter titles, if you so choose. Use an 
established format, such as ISBD 

 Click in the “Extent Statement” box to auto-fill it after you have filled in Type of Unit, etc.  
 Click in the “Composite Key” Text box. This is created based on data already entered.  It can be 

changed based on the boxes checked in the right-hand column, entitled AAP. 
 If you need to add an element not offered in the template, place the cursor on the field 

above where you want the new field to appear and press <F4>. Start typing the name of 
the element you need, or simply look at the drop-down list of elements available. 

 Be sure to save the record! 

Create a New Record for the Work 

 Scroll to the bottom of the Manifestation 
record and find the “Expression Manifested” 
text box. 

 Press <F5> in this text box 
 Select Create New Work 
 Select the appropriate template 
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The “Build WEM” Process 

Certain Work data will be auto-filled from data that you provided in the Manifestation: 

 Preferred Title for the Work (from Title Proper)
 
 Date of Work    (from Date of Publication) 

 Source Consulted   (from Title Proper and Date of Publication)
 

Note that all of these auto-filled elements can be changed, if necessary. 

 Remove initial article(s) from the “Preferred Title for the Work” and capitalize the first word of 
the Title 

 Change “Date of Work” and other elements, as needed, to reflect the actual work  

 As needed, change the “Creator” label to “Author” or another more specific relationship 
designator, if known. Click on the dropdown arrow next to Creator and select a more specific 
term. If nothing more specific is known, the general relationship designator is fine. 

 Link to the Author, if already in the Entity Index: 
 Press <F5> 
 Click on Link to (EI) 
 Select Authorized Access Point for the Person/CB/F Entity 

 If the Author is not already in the Entity Index but does exist in the NAF, place the cursor where 
the Name would be, and search using <F3>. Import from NAF and modify the Person record as 
needed. 
Or… 

 If the Author is not already in the Entity Index and does not exist in the NAF, place the cursor 
where the Name would be, press <F6> and select Create New Person. Fill out the information 
as available and save the record. 

 Click in the “Authorized Access Point” text box in the Work Template 

Notice that the AAP changes to reflect which elements have been checked in the AAP column. 
You can easily change this by changing what has been checked. 

 For any compilation, consider the possibility of creating Whole/Part Relationships to the 
individual Works. This would entail creating at least a Work and Expression for each 
component part of the resource and linking them to the established Manifestation. The 
alternative is to create a Related Manifestation as a structured description (like the current 
contents note). If you opted to do this, you would do it in the RIMMF Manifestation 
record. 

 Enter fully established for “Status of Identification” 
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Create a New Record for the Expression 

 Press <F5> in the Expression of Work text box 
 Select Create New Expression 
 Select the appropriate template 

Certain Expression data is 
provided as constant data because 
of the template you chose: 
 Content Type:  

Text 
 Language of Expression: 

English 

Other data will be auto-filled for you by the “Build WEM” process from data that you provided 
in the Work or Manifestation: 

 Date of Expression (from Date of Work) 

 Authorized Access Point  (from the AAP of the Work + Content Type) 

 Source Consulted   (from Title Proper and Date of Publication)
 

 Enter fully established for “Status of Identification” 

 Add other attributes as needed, such as: 
 illustrative content  
 color content 
 supplementary content 

Notice any entities in the statement of responsibility.  Is there an editor? An illustrator? These are 
contributors and can be added as relationships at the Expression level.  
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Add a Link in the Expression to a Contributor 

 Press <F4> to create a new field (if it is not already in the template), and type Contributor. 

Once you’ve selected “Contributor,” the more specific relationship designators for type of 
contributor become available (this example assumes you are adding an editor) 

 Change the “Contributor” label to “Editor” or another relationship designator, as appropriate  
 Click on the label, type edi and select Editor 
 <Tab> to the text box 
 Click in the Text box for “Editor” 
 Press <F5> 
 Click on Link to (EI) 
 Select Name of Person 

o See instructions on p. 5 above for what to do if the Person is not in the Entity Index. 
 Save the record 

View the R-Tree 

 Click on R-Tree, from the Work record 

 Click on the Person heading 

 Press <Ctrl> + <R> to switch to the R-Tree for the Creator
 
 Examine all relationships to be sure that they are accurate 


Notice that the relationship labels are correctly given as “Author of,” etc., based on the 
relationship designators chosen at the Work and/or Expression level. 

 Close everything, if you are finished 
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Creating a Description in BIBFRAME 

Alert! 

In this demonstration, we are using the current production version of the BIBFRAME Editor, 
which is intended for internal LC testing only. 

In Appendix C at the end of this material, you will find a link to an external version of the Editor 
which you are welcome to experiment with, and please remember to report the results of your 
experimentation. 

Brief Overview of the BIBFRAME Editor 

The Editor contains “Profiles” -- templates -- for each of the types of resources you see at the 
left. For each, you can select one of three profiles -- “Work,” “Instance,” or “Work/Instance.”   

 In this exercise, we will select the Work/Instance profile, which affords the greatest flexibility 
for recording the greatest range of cataloging elements. 

The profile is divided into the WEMI entities  -- Work, then Expression, then Manifestation. 
This is intended to help you use your knowledge of FRBR/RDA to find the appropriate field in 
which to enter data (there is – duh! -- no ‘tag list’ such as you find in a MARC-based system). 1 

Each element is labeled in blue with its RDA name and instruction number.  And – here is a 
really helpful feature – each of the links takes you right to that instruction in the RDA Toolkit. 

 The vocabulary in the Editor is the RDA vocabulary, because that is what you know. What 
you don’t see is the behind-the-scenes BIBFRAME vocabulary. So the result is that you 
create a BIBFRAME ‘record’ -- without necessarily knowing BIBFRAME.   

Four different types of ‘fields’ are used to enter data: 
 A direct-entry field, in which you simply type data and then click on the “+” sign.; two 

examples of this are “Illustrative Content” and “Statement of Responsibility” 
	 A dialog field, in which you click on the shaded button and type the appropriate data; two 

(slightly different) examples of this are “Principal Creator” and “Publication Statement.”  
In some of these (e.g., “Creator”), the dialog offers an opportunity to search for an 
authorized form or term. 

 A direct-entry field pre-populated with ‘default’ text; an example is “Content Type” 
 A direct-entry field in which you click to select (or type and then select) from a menu of 

possible values; an example of this is “Language of Expression”  

 For the purposes of this exercise, we will assume that there is no BIBFRAME description 
available – we are starting “from scratch.” 

1 It has been our experience that knowing FRBR and RDA solidly is a great advantage in using the Editor.  Those 
who struggle with RDA are likely to struggle with where to enter data in the Editor. 
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As in current MARC-based systems, it does not really matter where in the profile you start.   

We’ll start with the Manifestation because that is how many catalogers approach a resource. 

Manifestation Elements 

 Click on the Title Proper button and type: 
Can we talk? 
 Then click on both the + and 

Save changes 

The title displays, with two additional 
buttons, used to edit or delete the element: 

 Click on the Other Title Information 
button 
In the text box, type: 

the rise of rude, nasty, stubborn 

politics
 
 Then click on both the + and Save 


changes 

 Again: after the element is saved, 
you can click on the pen to edit or the trash can to delete the element 

 You can ‘hover’ the cursor over the element to read the complete text in the tooltip 

 Click in the Statement of Responsibility direct-entry box and type: 
editors, Daniel M. Shea (Allegheny College), Morris P. Fiorina (Stanford University) 
 Then click on the + 
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 Click on the Publication Statement button 
to enter its three sub-elements in a single 
dialog: 
	 Click in each box and type the 

appropriate data 
 Be sure to click on the + after each 

sub-element! 

	 And be sure to click on Save 
Changes after you have “plused” 
each sub-element! 

 Note that the display looks unusual, 

because we did not enter the 

punctuation separating sub-elements.  

We did this precisely because they 

ARE different sub-elements (we will see how they display in the ‘record’). 


If we had chosen to record more than one place of publication for this resource (as on the 
title page), we could have done one of the following: 
o	 include the separating “[space]; [space]” between places 
o	 enter one place, click on the +, enter another place, and click on the + again. 

 Click in the Copyright Date box 
 Type <Ctrl>+<Alt>+6 to produce 

the © symbol (called for by RDA) 

 Type 2013 

 Then click on the +
 

 Click in the Mode of Issuance box to 
select single unit from the menu 

 We can simply accept the defaults for 
Media Type and Carrier Type. Nothing 
further needs to be done with these. 
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 Click in the Extent box and type: 
vi, 217 pages 
 Then click on the + 

 Click in the Dimensions box and type: 
23 cm 
 Then click on the + 

 Click in the Call Number box and type: 
JK1726.C36 2013 
 Then click on the + 

Work and Expression Elements 

How will we enter these Work and Expression elements (and perhaps other optional ones)? 
 Preferred Title 
 Subjects 
 Related Works 
 Contents Note 
 Content Type 
 Language of Expression 
 Illustrative Content 
 Supplementary Content 
 Contributors 

BIBFRAME has no “Expression” entity. But the Editor has been designed so you can use your 
knowledge of the FRBR structure underlying RDA to see where to enter these elements.  We will 
scroll to the top of the profile and work down through the “Work” elements and then the 
“Expression” elements.  

 Click on the “Preferred Title for the Work” Title button and type 
Can we talk? 

 Then click on both the + and Save 


changes
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 Click on the Subjects button next to “Subject of the Work” to enter the first subject: 

This full string is not represented by an authority record, so we need to use the “Input” function: 
 Click in the “Input Subject” box and type: 

Political culture—United States—
 
History—21st century
 
 Then click on both the + and Save 


changes 

 Remember that you can hover the 

cursor over the text box to review 

the entire content of the element 


 Click on the Subjects button again to enter the second subject: 

Again, this full string is not represented by an authority record, so we’ll use the “Input” function: 
 Click in the “Input Subject” box and type: 

Politics, Practical—United States—History—21st century 
 Then click on both the + and Save changes 

 Click on the Subjects button again to enter the third subject: 

Again, this full string is not represented by an authority record, so we’ll use the “Input” function: 
 Click in the “Input Subject” box and type: 

Courtesy—Political aspects—United States—History—21st century 
 Then click on both the + and Save changes 

The Editor now displays all three subjects you have input: 
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“Related Works” Elements 

RDA and LC-PCC PS 25.1 direct that, for a resource such as this, we should: 

“give an analytical authorized access point for the predominant or first work in the compilation 
when it represents a substantial part of the resource”  

We could disagree about whether the first part of this whole represents a “substantial” part of this 
resource, and whether recording a Contents Note would be burdensome.  But for the sake of 
practicing the entering of these data elements, we will put those discussions aside. 

 Click on the Related Works button 
In the “Record…” box, type: 

Container of (work):  Shea, Daniel M. Can we talk? 

 Then click on the +
 

and Save changes
 

 Click in the Contents Note box and type: (to save time, we will only type the first two parts) 
Chapter 1. Can we talk? The rise of rude, nasty, stubborn politics / Daniel M. Shea and 
Morris P. Fiorina – Chapter 2. The powerful – if elusive -- nature of civility / Susan 
Herbst 
 Then click on the + 

The next set of elements are entered in the “Expression” area of the profile.  

 Click in the Content Type box 
 We can accept the default of text, but we will also apply the option to add an additional 

type for the illustrations 
 Type st and select still image.
 

The Editor now displays both Content 

Type values 


 Click in the Language of Expression box, 
type eng, and select English 

 Click in the Illustrative Content box and 
type illustrations 
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 Click in the Supplementary Content box 
and type 

Includes bibliographical references 

 Click on the Contributor button to record the first editor 
 Click on the Person button 
 Click in the “Search…” box 

 Type shea, dan
 
 Select Shea, Daniel M from the 


list 
	 Click on the + at the end of the 


“Record …” box (selecting from a 

menu equates to ‘recording’) 


 Click on Save changes 

A Relationship Designator is not required 

for this contributor. But we will see how 

to record one in the BIBFRAME Editor: 


 Click in the “Search Relationship 
Designator” box 
 Type ed 
 Select Editor from the list 
 Click on the + at the end of the 

“Record …” box 

 Click on Save changes
 

Repeat these steps for the second editor. 

The Editor now displays both editors 
under the “Contributor” button: 




!!! There is no current capability to retrieve a record created earlier.  Therefore, it is 
especially important to “Preview” and analyze the record before clicking on “Save” (in 
fact, you cannot “Save” the record except from the “Preview” view).  

Click on Preview 
Click on Save 
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Exporting BIBFRAME to RDF 

The preview shows the BIBFRAME data in JSONLD-Expanded format. The JSONLD can be 
copied in its entirety and pasted into an RDF translator to convert it from JSONLD to RDF 
XML. A common free conversion tool is RDF Translator http://rdf-translator.appspot.com/ 
After converting from JSONLD to RDF XML, the data can be copied and pasted into the W3C 
Validation service: https://www.w3.org/RDF/Validator/rdfval  The data can then be “parsed” 
into triples (table below) and an RDF graph (portions on the following pages).  

BIBFRAME Triples 

BIBFRAME Instance Graph (Fragment) 
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BIBFRAME Work/Expression Graph (Fragment) 
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Unit 3: Online Serial in RIMMF and BIBFRAME 

Creating a Description in RIMMF – Creation by Import, Using <F3>  

Find and View the Manifestation Record for Importing 

 Open RIMMF by double-clicking on the icon 

This process starts with the assumption that the resource has already been cataloged using 
MARC. RIMMF is primarily searching the LC catalog and authority file. 

 Press <F3> 
You can search by Title, Name, ISBN, LCCN, or 
by ANY. Apply basic search skills: the more 
specific your strategy, the more successful your 
search. 

 Change the Search Source to [BIB] Title 
 Search for Neurology Genetics 

This retrieves several hits, but only one is the 
journal we are searching for. 

 Click on View MARC to view the original MARC record and confirm it is the one you want. 

This is a serial, which frequently has a 130 field. Anytime a bibliographic record has a 130 or a 
240 field, a Work or Expression Authority record is possibly available, and you have the option 
of importing the Work and/or Expression before importing the Manifestation.  This example will 
proceed on the assumption that you are NOT doing that (this specific example does not have a 
130), but instead starting with a Manifestation import, as that is the more usual situation. 

 Select the MARC record for the bibliographic record you have chosen 
 Click on Import on the Search screen 

This will bring in the Work/Expression/Manifestation complex of records for the MARC record. 
If a Work and/or Expression has already been brought in for that Manifestation, it will show 
them in this list, but the box on the right will not be marked. If there are Persons/Corporate 
Bodies/Families related to this Manifestation, they also will be brought in as part of the complex 
of records. All items with an asterisk in this list are being created by the RIMMF program. 
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 Click on the down arrow next to Import at the center bottom of the screen and select Import 
selected records, which imports all records with a checkbox marked on the right hand side of 
this screen. 

 Click on OK for “X records imported” 

The resulting screen shows a list of imported records. You may double-click on each record in 
order to open it and examine the metadata and be sure that it is in the correct location. You may 
also close this screen and open the records from the Entity Index. 

In the MARC to RIMMF/RDA transition, certain things are assumed by necessity.  For example, 
any 700 fields are assigned the role of contributor, even if that person is in fact a second author 
(i.e., a ‘creator’, in the FRBR/RDA conception). This means that you need to examine each 
record after import in order to confirm that it correctly reflects the information and relationships 
of the work in hand. 

 Open the Manifestation record by double-clicking on the Manifestation title.  
 Examine each attribute to be sure it accurately reflects the resource. Add, modify, or delete as 

necessary. 

If you need to add an element not offered in the template, place the cursor on the field above 
where you want the new field to appear and press <F4>. Start typing the name of the element 
you need or simply look at the drop-down list of elements available. 

 Click inside the “Extent Statement” field to change it from the imported phrase to the composed 
field. 

 Check or uncheck the fields that can be added to the Composite Key, as needed 
 (This is a RIMMF field, and the Manifestation version of an Authorized Access Point) 
 Click inside the Composite Key field; it will change to reflect the elements that have been 

added or removed 

 Save the record 

 Do the same with the Expression and Work records. Clarify any relationship designators by 
adjusting the general terms to more specific terms, as applicable. 

 Check or uncheck the fields that can be added to the Authorized Access Point.  
 Click inside the Authorized Access Point to reflect elements that have been added or removed 

View the R-Tree 

 Click on R-Tree, from the Work record 
 Click on the Person heading 
 Press <Ctrl> + <R> to switch to the R-Tree for the Creator 
 Examine all relationships to be sure that they are accurate 

 Close everything, if you are finished 
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Creating a Description in BIBFRAME 

 For the purposes of this exercise, we will assume that there is no BIBFRAME description 
available – we are starting “from scratch.” 

 We know that there is no BIBFRAME description available, so there is no need to search 
for BIBFRAME resources. Again, we will use the “Work, Instance” profile. 

In the BIBFRAME “Work, Instance” profile, we can enter the RDA “Manifestation” elements: 

Manifestation Elements 

 Click on the Title Proper button and type: 
Neurology. Genetics 
 Then click on both the + and Save 

changes 

The title displays, with two additional 
buttons used to edit or delete the element: 

 Click on the Key Title button 
(This step assumes that you have access to 
the ISSN Portal and can confirm ISSN 
related data. An abbreviated key title has 
not been assigned.) 

In the Key Title box, type: 
Neurology. Genetics
 
 Then click on both the + and Save 


changes
 
After the element is saved, click on the pen to edit or the trash can to delete the element 

 Enter the “Numeric and/or Alphabetic Designation of First Issue or Part of Sequence” 

 Click on the + after entering the data. 
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 Enter the “Chronological Designation of First Issue or Part of Sequence” 

 Click on the + after entering the data. 

 Click on the Publication Statement button 
to enter its sub-elements in a single dialog:  
 Click in each box and type the 

appropriate data 
	 Be sure to click on the + after each 

sub-element! 

	 And be sure to click on Save 
Changes after you have “plused” 
each sub-element! 

 Note that the display looks 
unusual, because we did not enter 
the punctuation separating sub-
elements.  We did this precisely 
because they ARE different sub-elements (we will see how they display in the ‘record’).  

 If we had chosen to record more than place of publication for this resource (as on the title 
page), we could have done one of the following: 
o	 include the separating “[space]; [space]” between place, or 
o	 enter one place, click on the +, enter another place, and click on the + again (better?) 

 Click in the Mode of Issuance box to 
select serial from the menu 
 Then click on the + 

 Click in the Frequency box and type 
Bimonthly 
 Then click on the + 
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 Click in the Note on Title box and type 
Title from PDF cover
 
 Then click on the +
 

 Click in the Issue, Part, or 
Iteration Note box and type 
Description based on Volume 1, 

Number 1 (June 2015) 

publishers web site, viewed March 10, 2016 

	 Then click on the + 

 Click again in the Issue, Part, or Iteration Note box and type 
Latest issue consulted: Volume 2, Number 3 (June 2016) viewed March 10, 2016 

 We can simply accept the defaults for 
Media Type and Carrier Type. Nothing 
further needs to be done with these. 

 Click in the Call Number box and type 
QP356.22 
	 Then click on the + 
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Work and Expression Elements 

How will we enter these Work and Expression elements (and perhaps other optional ones)? 
 Principal Creators and other Creators 
 Preferred Title 
 Place of Origin 
 Subjects 
 Dewey Classification 
 Content Type 
 Language of Expression 

BIBFRAME has no “Expression” entity. But the Editor has been designed so you can use your 
knowledge of the FRBR structure underlying RDA to see where to enter these elements.  We will 
scroll to the top of the profile and work down through the Work, and then Expression, elements.  

This work doesn’t have a “Principal Creator” but has an issuing body that would be considered 
an “Other Person, Family, or Corporate Body Associated With a Work (RDA 19.3).”  

 Click on the Other Person, Family … button 

 Select “Corporate Body” 
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 Search for the corporate body in the Search 
LCNAF … search box. 
 Type american academy of neur 
 Select the desired entity from the 

menu 
 Then click on the + and Save 

changes 

 Search for the relationship designator in the 
“Search Relationship Designator … ” box 
 Type iss 
 Select the desired term from the 

menu  
 Then click on the + and Save 

changes 

The issuing 
body has now 
been recorded: 

 Click on the Title button next to 
“Preferred Work Title” and type 
Neurology. Genetics. 
 Then click on both the + 

and Save changes 
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 Click on the Place button next to “Place of Origin of the Work.” 
This dialog allows you to search for an authorized form of the place or to record the place of 
origin if known. 
	 Type Philadelphia and then select 


Philadelphia, Pa.
 
 Then click on Save changes
 

  Click on the Topic button next to 
“Subject of the Work” to enter the 
subject: 
	 Type Neurology and then select 

Neurology—Periodicals 
 Then click on both the + and Save 

changes 

The Editor now displays the subject 
heading you have input: 

 Click on the “Dewey Classification 
Information” button. 

The default edition number is 23; there is no need to do anything if that is correct. 
 Enter the Dewey Classification number 
 Then click on both the + and Save changes 
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The next few elements are entered in the “Expression” area of the profile. 

 Click in the Content Type box 
 We can accept the default of text 

 Click in the Language of Expression box, 
type eng and select English 

 Click on Preview 

Exporting BIBFRAME to RDF 

The preview shows the BIBFRAME data in JSONLD-Expanded format. The JSONLD can be 
copied in its entirety and pasted into an RDF translator to convert it from JSONLD to RDF 
XML. A common free conversion tool is RDF Translator http://rdf-translator.appspot.com/ 

After converting from JSONLD to RDF XML, the data can be copied and pasted into the W3C 
Validation service: https://www.w3.org/RDF/Validator/rdfval  The data can then be “parsed” 
into triples (table below) and an RDF graph (portions on the following pages).  

BIBFRAME Triples 
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BIBFRAME Instance Graph (Fragment) 
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BIBFRAME Work/Expression Graph (Fragment) 
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Unit 4: Notated Music in RIMMF and BIBFRAME 

Creating a Description in RIMMF – Creating by Import, Not Using <F3> 

Find and Export a Bib Record From Any Library Catalog 

 Open RIMMF 

Start from the Main Menu 

For the previous resource, we used <F3> to go to the LC public catalog and download and 
import a MARC record to RIMMF.  For this resource, we will get records from any catalog that 
allows export of MARC records from the public catalog or for which you have cataloging access, 
and so can export a MARC record (e.g., from OCLC, if you are a member). 

 In your browser, Go to: http://catalog.loc.gov/ 
 Search for a resource 
 Open the record 
 Click on the Save Record option (at the far left of the screen) 

 Save format: MARC (Unicode/UTF-8) 
 Click on Save 
 Save the record to somewhere where you can find it easily (e.g., your Desktop) 

Unless you rename it, a record that you export from the LC catalog will be named records.mrc. 

As mentioned earlier, you can do something 
similar from any open catalog that offers the 
UTF-8 MARC option to download. If you 
have to save it in a program such as Wordpad 
or Notepad, do so in a file ending with .mrc 
and make sure that you download the UTF-8 
version, so that RIMMF can handle the 
diacritics.   

Make sure that, after saving, it ends ONLY in .mrc and that the program hasn’t added something 
like .txt to the end of it. If the program has added that, simply Rename and delete that portion of 
the name. (e.g., change the filename record.mrc.txt to record.mrc). 

Import the Bib Record 

 Find the saved record 
 Drag and drop the record onto the RIMMF home screen. 
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From this point on, the process works exactly like the <F3> import seen in the previous Unit. 

 Click on the down arrow next to the Import button 
 Select Import selected records 
 Click on OK for “X records imported” 

The resulting screen shows a list of imported records. You may double-click on each record to 
open it and examine the metadata and be sure that it is in the correct location. You may also 
close this screen and open the records from the Entity Index. 

In this specific example, I am importing a music score of The rite of spring, by Igor Stravinsky, 
which I exported as a bibliographic file from OCLC (ARN # 944289946).  Recalling what was 
said earlier about importing a record with uniform titles, I first searched under the NAF N/T in to 
import the Work record for The rite of spring, as well as the NAR for Igor Stravinsky, so that 
RIMMF would not have to create the Work record, but would instead use the authority record, 
with all the variants available. This means that when I import the score record from my Desktop, 
RIMMF will recognize the Work and Person in the database, and not re-import them.  If I did not 
do this, the Work record would be created by RIMMF and not include the rich data already 
found in the authority record for this Work. 

Remember that you need to examine each record after importation in order to confirm that it 
correctly reflects the information and relationships of the work in hand. 

 Open the Manifestation record by double-clicking on the Manifestation title.  
 Examine each attribute to be sure it reflects the resource. Add, modify, or delete as necessary. 

If you need to add an element not offered in the template, place the cursor on the field above 
where you want the new field to appear and press <F4>. Start typing the name of the element 
you need or simply look at the drop-down list of elements available. 

 Click in the “Extent Statement” field to edit it from the imported phrase to the composed field. 
 For a music score, there are two parts to this extent statement.  Record the number of 

pages as a Number of Subunits and Type of Subunits (Text). 
	 You also need to add a second extent statement for 5 parts.  Use Number of Units and 

Type of Units (Notated Music).  
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 Clean up the Dimension statement by moving the 28 x 22 cm after the Extent statement for the 
score and the 28 cm after the Extent statement for the parts. 

 Move attributes (e.g., note information) to the appropriate level of entity  
 Check or uncheck the fields that can be added to the Composite Key, as needed. 
 Save the record 

Edit the Expression and Work Records 

 Adjust any relationship designators from general terms to more specific terms, as applicable. 
 Add “Medium of Performance of Musical Content” to the Expression record and paste in the 

note information from the Manifestation that applies to the Expression. 
 Remove “Sponsoring Body” from the Work entity 

o	 Why did we do this? It is because the sponsoring body is really the San Francisco 
Symphony’s Keeping Score educational outreach program, and not the San 
Francisco Symphony Orchestra itself. Optionally, a PCC cataloger could have 
established an authorized access point for the program, and then add that entity as 
a sponsoring body in this description. But in this case, the cataloger decided to 
omit the sponsoring body, since it was incorrect. 

	 Check or uncheck the fields that can be added to the Authorized Access Point.  Click 
inside the AAP field to reflect the elements that have been added or removed. 

View the R-Tree 

 Click on R-Tree, from the Work record 
 Click on the Person heading 
 Press <Ctrl> + <R> to switch to the R-Tree for the Creator 
 Examine all relationships to be sure that they are accurate 

 Close everything, if you are finished 
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Creating a Description in BIBFRAME 

 For the purposes of this exercise, we will assume that there is no BIBFRAME description 
for the RDA expression available – we are starting “from scratch.” 

Let's start with the RDA work – The Rite of Spring.  

 Remember that for the print monograph, we started with the Manifestation/Instance.  
BIBFRAME is ‘order-agnostic’ about the entering of individual elements.  

There are some pitfalls with this resource.  Rather than discard this example -- which was a 
sound recommendation by people who know a lot more about this than I do! -- let's look at the 
problems, for the sake of discussion.  There is an RDA problem: as RDA is currently written, 
Medium of Performance is a Work attribute, not an expression attribute. But since we are 
describing an arrangement -- an RDA expression -- of another musical work, and our 
arrangement is for a different Medium of Performance, how are we going to include the Medium 
of Performance for this arrangement? In light of the JSC Music Working Group's RSC 
Discussion Paper (6JSC/MusicWG/Discussion/3, 31 July 2015 – titled Additional element for 
Medium of Performance of the Expression) and taking the FRBR LRM study into account, let's 
imagine that we can safely describe Medium of Performance for a musical expression. 

We are only playing around here – this is not the real world.   

The reason I suggest we play around is because of the BIBFRAME definition of “Work.” 
Remember that there is no such thing as a BIBFRAME expression. So in BIBFRAME terms, we 
have two works – the original ballet Rite of Spring, and the arrangement for wind quintet. In 
RDA terms, we only have one work and one expression of that original work. This dichotomy 
was one that kept coming up in the LC BIBFRAME Pilot, and it is yet to be fully resolved.     

Another pitfallwith this resource – and many of us who work with copy cataloging can relate to 
this – we discover that this arrangement of Rite of Spring is not “complete” – it is a woodwind 
arrangement of selections from Rite of Spring so we will need to add “Selections” to the 
preferred title. 

And can you deal with one more complication? In researching the work, we discover that the 
arranger made two arrangements for woodwing quintet of Rite of Spring! In this example and in 
the following example, we are describing the longer of the two arrangements. But because we 
discovered that there are two arrangements for the same medium of performance, we will need to 
deal with conflict resolution as well.   

Remember, these types of complications and pitfalls are not uncommon – you may have to deal 
with similar situtions when cataloging other resources.    

We'll first consider the RDA work and the first BIBFRAME work – Stravinsky's Rite of Spring. 
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Work Elements 

Here is some information about the Work Rite of spring  that we will use to populate the Work 
area of the BIBFRAME profile: 

 Creator of Work (RDA 19.2) 
o Stravinsky, Igor, 1882-1971 (NAF) 


 Preferred Title for a Musical Work (RDA 6.14.2) 

︠ ︡ ︠ ︡o Vesna sviashchennaia


 Variant Title for a Musical Work (RDA 6.14.3) 

o Rite of spring 


 Form of Work (RDA 6.3) 

o Ballets (Music) (LCGFT) 


 Date of Work (RDA 6.4) 

o 1913 


 Place of Origin of the Work (RDA 6.5) 

o Clarens (Switzerland) (NAF) 


 Medium of Performance of the Work (RDA 6.15) 

o Orchestra (LCMPT) 

Expression Elements 

Here is where things really get interesting … 

Our woodwind quintet arrangement of Rite of Spring is an RDA expression of the work for 
ballet. But in BIBFRAME terms, this RDA expression is a new BIBFRAME work. 

To begin, after we have described the RDA work, we contemplate the RDA expression – with its 
own unique Medium of Performance (an RDA work element!) 

Note the “non-RDA” hyperlink “Medium of Performance of the Musical Expression – 
6JSC/MusicWG/Discussion/3”. Since Medium of Performance of the Musical Expression does 
not yet exist in RDA, the link goes to the JSC Music Working Group's RSC Discussion Paper. 

We have the longer of the two arrangements for woodwind quintet, with some “doubling” (with 
piccolo for flute, and clarinet in B-flat for clarinet in A). 

Here is a partial view of a very long input screen for Medium of Performance: 
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This is an experimental 
screen that is being tested 
not only in BIBFRAME, 
but also in the wider music 
community at large, as 
refinements are made in the 
Medium of Performance 
vocabulary as it will be 
used in Linked Open Data. 

We won't fill this out now, 
in the interest of time. The 
lookups are linked to 
LCMPT – a controlled 
vocabulary developed by 
LC and the Music Library 
Association (MLA). 
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 We can simply accept the Content 
Type, which is pre-programmed into 
the profile for Notated Music: 


We can infer the Date of Expression from the manifestation date 
Click in the Date of Expression box and type 2013 

 Be sure to click on the Plus signs to save all of the data!  

“Form of Musical Notation” is a controlled term. 

 Click in the Form of Musical Notation box and type sta, then select the proper term (staff 
notation) from the list which the Editor looks up in RDA 7.13 

“Format of Notated Music” is also a controlled term. 

 Click in the Format of Notated Music box and type sc, then select the proper term (score) from 
the list which the Editor looks up in RDA 7.20 (this time the link is made to the RDA Registry -- 
http://rdaregistry.info/termList/FormatNoteMus/): 
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We have done a good job identifying the expression through its Medium of Performance, but 
what about the contributor who created the arrangement? 

We can search for his name in the LC/NACO Authority File by clicking on Contributor.  And we 
might consider adding a relationship designator as well ...  

 Click on the Contributor button 

 Click on the Person button 

 Type russell, jonathan and select 
the correct person from the menu 

 Click in the Search Relationship 
Designator box and type arr 

“arranger” appears on the menu 

But where is the “of music” 
extension that we see in RDA 
Appendix I? 

There are some RDA relationship designators that are not in the lookup in id.loc.gov, so in this 
case, we can record the relationship designator as a “literal” and key it in explicitly: 

LC/PCC Secretariat 36	 May 2016 

http:id.loc.gov


 

 
 

 
 
 
 

 
 
 
 
 
 
 
 
 
 

 

  

 
 

 
 

 

 

 
 

 
 

 
 

 
 

“Moving-Away-From-MARC”-a-thon 	 Unit 4: Notated Music in RIMMF and BIBFRAME 

 Click in the “Record Relationship Designator … box 
	 Type arranger of music and click 

on the + sign 

Now we can key in the authorized access point for our expression – but remember that this RDA 
expression is going to be a BIBFRAME work! And LC policy at this point is to make this an 
“undifferentiated” expression – that is why there is nothing added to the subfield $o arranged to 
make this a unique expression authorized access point. And remember, we already have 
discovered that there are two arrangements by the same arranger, with the same medium of 
performance, for these selections from Rite of Spring! 

	 Remember to click on the + sign 

Manifestation Elements 

Most of the data that will be described in this part of the web-form follows the examples in the 
earlier resources, so we won’t go through those elements here. But there is some information 
that is unique to notated music cataloging, so let’s take a look at those elements: 

The Extent of our resource consists of the score itself, plus five parts.  
RDA 3.4.3 “Extent of Notated Music” covers this unique extent statement: 

 Click in the “Extent” box, type 1 
score (59 pages) and click on + 

 Click again in the box, type 5 
parts, and click on the + 

Did you notice that Number and Type of Units are included in the general Extent area of the 
profile? 

There also is a Music Plate Number associated with this resource. 
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 Click on the button next to “Identifier for the Manifestation” 

 Click on the Music Plate Number button 

 Click in the “Plate Number” box 
 Type 10016 and click on the + sign 

In most other respects in the Manifestation/Instance area, this resource is not unusual.  

 Click on Preview 
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Exporting BIBFRAME to RDF 

The Preview shows the BIBFRAME data in JSONLD-Expanded format. The JSONLD can be 
copied in its entirety and pasted into an RDF translator to convert it from JSONLD to RDF 
XML. A common free conversion tool is RDF Translator http://rdf-translator.appspot.com/ 
After converting from JSONLD to RDF XML, the data can be copied and pasted into the W3C 
Validation service: https://www.w3.org/RDF/Validator/rdfval  The data can then be “parsed” 
into triples (table below) and an RDF graph (portions on the following pages).  

BIBFRAME Triples (Partial view—Literal values) 

BIBFRAME Triples (Partial view—Targeted values) 
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BIBFRAME Instance Graph (Fragments) 
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Unit 5: MP3 Download in RIMMF and BIBFRAME 

Creating a Description in RIMMF – Manual Creation, Using ‘Cloning’  

Open RIMMF 

 Open RIMMF by double-clicking on the icon 

Clone the Expression 

Open a record for which you already have a Work/Expression/Manifestation.  

For this resource, we will open an already-created Expression, and clone that. 


We have a record for the W/E/M complex for Stravinsky’s The rite of spring, the longer of two 
arrangements by Jonathan Russell.  We will now add a new Expression for a performance of this 
arrangement, performed by the Imani Winds woodwind quintet. 

 Open the Expression record you wish to use. 
 Click on File > Clone Record; 

or press <Ctrl> + <Alt> +<o>. 

 Select the appropriate template 
 Click on OK 
 Click on Add record 

NOTE: You cannot edit the new, cloned record until you have added it. 

Now, examine this record to see what needs to be added or changed in this new record. 

Examine each attribute to be sure it accurately reflects the resource. Add, modify, or delete as 
necessary. Change field attributes by either making a different selection from a drop-down list or 
simply deleting what is in the field and typing the new information. 

If you need to add an element not offered in the template, place the cursor on the field above 
where you want the new field to appear and press <F4>. Start typing the name of the element 
you need or simply look at the drop-down list of elements available. 
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 Record the “Duration” of 18 min., 59 sec. 
 Record the “Place of Capture” and “Date of Capture”  

 Davies Symphony Hall, San Francisco, CA 
 2012 September 23 

 Add the contributor Imani Winds, using <F3> to search 
	 Change the relationship 


designator to “Performer” 

once the record for Imani 

Winds has been imported. 


 Delete “Language of Expression” and “Script Notation” 

 Check or uncheck the fields that can be added to the Authorized Access Point.   
 Click inside the Authorized Access Point field to reflect the elements added or removed 

 Save the record 

Create a New Record for the Manifestation 

 Press <F5> in the Manifestation of Expression Text box 
 Select Create New Manifestation 
 Select the appropriate template 

Certain Manifestation data is provided for you as a result of the template you have chosen.  

NOTE: 	 There is not a template available currently for an online recording of performed 
music. Simply choose the closest template  and modify as necessary. 

You will need to:  
	 Change the note on Title to Title from title screen (source, date viewed). 
	 Change “Media Type” to audio from the drop-down list 
	 Press <F4> for a new field and type uni to find the URL; paste URL source 
	 “Carrier Type”: select online resource from the drop-down list 
	 The “Extent Statement” should read: 1 online resource (1 audio file) 
	 “Type of Recording”: select digital from the drop-down list 
	 “File Type”: select audio file from the drop-down list 
	 “Encoding Format”: select MP3 from the drop-down list 
	 The relationship to the Expression Manifested is already there, because the new 

Manifestation started from within the correct Expression record. 
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 Save the record 

View the R-Tree 

 Click on R-Tree, from the Work record 
 Click on the Person heading 
 Press <Ctrl> + <R> to switch to the R-Tree for the Creator 
 Examine all relationships to be sure that they are accurate 

Note that we now have 2 Expressions, both arrangements of the same orchestral work. 

 Close everything, if you are finished 
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Creating a Description in BIBFRAME 

 Now we have an iTunes MP3 download for a digital audio performance of the longer 
arrangement we described in the previous unit. 

 We can use our description of that expression, and create a new expression for this 
musical performance. 

Just as in the previous example, we can pre-populate the RDA Expression area of the Audio CD 
BIBFRAME Profile based on our previous work with the woodwind quintet score, and then we 
can modify the description to reflect the MP3 audio download. 

We are using the Audio CD BIBFRAME Profile since that was a resource type tested in the LC 
BIBFRAME Pilot – we will make adjustments to the Media and Carrier Types as needed, and 
we will be sure that the description does represent the MP3 download. 

Note that our arrangement of Selections is not represented by an authorized access point – we 
would need to use the same authorized access point we created in the previous example. The 
authorized access point we need has not yet been established in the BIFRAME resource database 
triple store. So we need to create it now, or wait for the one we created in the previous example 
to distribute to the BIBFRAME triple store.  
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We can accept the Content type that is in the Audio CD BIBFRAME Profile: 
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We have a Place and Date of Capture, and a Duration: 

And now we have a performing group – the Imani Winds: 
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Manifestation Elements 

In the interest of time, we will not enter the Manifestation elements 
 Title Proper (RDA 2.3.2) 

o Rite of Spring 

 Other Title Information (RDA 2.3.4)
 

o Arranged for wind quintet 

 Statement of Responsibility (RDA 2.4.2) 


o Stravinsky 

 Publication Statement (RDA 2.8)
 

o [United Kingdom] 
o [Parlophone Records Ltd.] 
o [2013] 


 Copyright Date (RDA 2.11) 

o p2013 


 Mode of Issuance (RDA 2.13) 

o single unit 


 Media Type (RDA 3.2) 

o audio 


 Carrier Type (RDA 3.3) 

o online resource 


 Extent (RDA 3.4) 

o 1 online resource (1 audio file) 


 Call Number 
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Exporting BIBFRAME to RDF 

BIBFRAME Triples (Partial view—Literal values) 

BIBFRAME Instance Graph (Fragment) 
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Appendix A. Discussion Questions 

Resource 1: Print Monograph 

Was it more difficult to comprehend the recording of catalog data into the Editor, since it did not 
involve your knowledge of MARC? 

Did your find that your knowledge of the FRBR/RDA entities and relationships helped you to 
understand the entry of data into the Editor? 

Resource 2: Online Serial 

Looking at a BIBFRAME visualization “rdf”,  can you identify a triple and explain its parts? 

Is a triple with a literal still linked data? 

Resource 3: Music Score 

How would you map the RDA Group One entities represented in the RIMMF output for this 
resource to the corresponding BIBFRAME “entities”?  (e.g., how many RDA Works, 
Expressions, and Manifestations are represented in this resource?  how many BIBFRAME 
Works and Instances are represented?)  

In describing this resource in BIBFRAME, we took an “unauthorized” approach to describing 
the arrangement with controlled Linked Data URIs in the Medium of Performance.  How did you 
deal with this situation when describing the resource in RIMMF?  Did it present any problems 
there in terms of Linked Data? 

Resource 4: MP3 Download 

Should we be limited to one ontology?  Why or why not? 

What are some reasons for libraries to transition to new technology like linked data? 
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Appendix B. RIMMF Export to RDF 

RIMMF can export to RDF from different points of entry. This example will start from the 
Entity Index. 

 Type <Ctrl> + <e> to open the Entity Index. 
 Highlight the records you wish to export (use standard Windows methods to select multiple 

files). 
 On the top right hand corner of the EI screen, click on the down arrow next to Export and select 

RDF (Simple). 
 Click on Export 

This will display a dialog box with a pre-created name for the file that contains all the records 
selected, which is partially based on the date. You can keep that name or assign your own.  

 Either way, click on OK and the file that is created is automatically saved to your Desktop. 

Once this is done, you will see a second dialog box, stating that ‘X’ records have been exported.  
 Click on OK to accept this 

The file that has been saved to your Desktop will have the .nt ending. This indicates that it has 
been saved in the N-triples serialization of RDF. It can be opened by any text reader software, 
such as Notepad. Once opened, the file will contain many URI’s, and the occasional literal (in 
quotation marks), which express the triples. These triples can be converted by one of the many 
RDF converter available on the web into other serializations.  
(I used www.easyrdf.org/converter to create the RDFXML serialization of this group of five 
records). 

Having converted them, you can see the visualization at the website 
https://www.w3.org/RDF/Validator/, which will produce a table of all the triples in this data 
model, as well as a .png image of the relationships. 
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Triples 
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Appendix C. Related Links and Resources 

RIMMF 

RIMMF home page (general information, links to user guide, and links for downloading):  
http://www.marcofquality.com/wiki/rimmf3/doku.php?id=rimmf 

Download RIMMF3 link (specific instructions and download options): 
http://www.marcofquality.com/wiki/rimmf3/doku.php?id=download&nocache 

BIBFRAME 

Bibliographic Framework Initiative website  
https://www.loc.gov/bibframe/ 

BIBFRAME Implementation & Testing 
https://www.loc.gov/bibframe/implementation/index.html 

BIBFRAME 1.0 Editor (Demo site) 
http://bibframe.org/tools/editor/# 

Resources for Hands-on Guided Practice Session 

Moving Away from MARC-athon” Resource Surrogates  
https://www.loc.gov/aba/pcc/documents/OpCo-2016/MovingAwayfromMARCSurrogates.pdf 
(PDF 1MB) 

Ordered List of Continuing Resources 
https://www.loc.gov/aba/pcc/documents/OpCo-2016/List-online-resources.pdf (PDF 92KB) 
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Appendix D. More on ‘Thinking in RDA’ 

Provided here are two schematics designed to help you get away from MARC and think of 
cataloging elements in BIBFRAME terminology (this page) or FRBR/RDA terminology (the 
next page). 2 

(Please note that the two schematics represent unrelated entities) 

 The schematic below illustrates the BIBFRAME vocabulary and relationships associated 
with a Person responsible for a Work: 

 The schematic on the next page illustrates the FRBR entities and RDA terms for a 
specific resource:  

2 We are indebted to Kate James, Policy and Standards Division, Library of Congress, for these schematics 
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